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COPYRIGHT © 2017 Hangzhou Hikvision Digital Technology Co., Ltd.  

ALL RIGHTS RESERVED. 

Any and all information, including, among others, wordings, pictures, graphs are the properties of 

Hangzhou Hikvision Digital Technology Co., Ltd. or its subsidiaries (hereinafter referred to be 

“Hikvision”). This user manual (hereinafter referred to be “the Manual”) cannot be reproduced, 

changed, translated, or distributed, partially or wholly, by any means, without the prior written 

permission of Hikvision. Unless otherwise stipulated, Hikvision does not make any warranties, 

guarantees or representations, express or implied, regarding to the Manual. 

About this Manual 

This Manual is applicable to iVMS-4200 Client Software. 

The Manual includes instructions for using and managing the product. Pictures, charts, images and 

all other information hereinafter are for description and explanation only. The information 

contained in the Manual is subject to change, without notice, due to firmware updates or other 

reasons. Please find the latest version in the company website (http://overseas.hikvision.com/en/).  

Please use this user manual under the guidance of professionals. 

Trademarks Acknowledgement 

and other Hikvision’s trademarks and logos are the properties of Hikvision in 

various jurisdictions. Other trademarks and logos mentioned below are the properties of their 

respective owners. 

Legal Disclaimer 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE PRODUCT DESCRIBED, WITH ITS 

HARDWARE, SOFTWARE AND FIRMWARE, IS PROVIDED “AS IS”, WITH ALL FAULTS AND ERRORS, 

AND HIKVISION MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, 

MERCHANTABILITY, SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, AND 

NON-INFRINGEMENT OF THIRD PARTY. IN NO EVENT WILL HIKVISION, ITS DIRECTORS, OFFICERS, 

EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR 

INDIRECT DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF BUSINESS PROFITS, 

http://overseas.hikvision.com/en/


User Manual of iVMS-4200 

ii 

BUSINESS INTERRUPTION, OR LOSS OF DATA OR DOCUMENTATION, IN CONNECTION WITH THE USE 

OF THIS PRODUCT, EVEN IF HIKVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF PRODUCT SHALL BE WHOLLY AT 

YOUR OWN RISKS. HIKVISION SHALL NOT TAKE ANY RESPONSIBILITIES FOR ABNORMAL OPERATION, 

PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER ATTACK, HACKER ATTACK, VIRUS 

INSPECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, HIKVISION WILL PROVIDE TIMELY 

TECHNICAL SUPPORT IF REQUIRED.  

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL RELEVANT LAWS IN YOUR 

JURISDICTION BEFORE USING THIS PRODUCT IN ORDER TO ENSURE THAT YOUR USE CONFORMS THE 

APPLICABLE LAW. HIKVISION SHALL NOT BE LIABLE IN THE EVENT THAT THIS PRODUCT IS USED WITH 

ILLEGITIMATE PURPOSES.  

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, THE LATER 

PREVAILS.
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Chapter 1  Overview 

1.1 Description 

iVMS-4200 is a versatile video management software for the DVRs, NVRs, IP cameras, encoders, etc. 

It provides multiple functionalities, including real-time live view, video recording, remote search and 

playback, alarm receiving, etc., for the connected devices to meet the needs of monitoring task. With 

the flexible distributed structure and easy-to-use operations, the client software is widely applied to 

the surveillance projects of medium or small scale. 

This user manual describes the function, configuration and operation steps of iVMS-4200 software. 

To ensure the properness of usage and stability of the software, please refer to the contents below 

and read the manual carefully before installation and operation. 

1.2 Running Environment 

Operating System: Mac OS X 10.9 to 10.12 

CPU: 3.00 Ghz Intel Dual-Core or above 

Memory: 1G or above 

Video Card: NVIDIA Geforce 9400 or above 

GPU: 256 MB or above 

1.3 Function Modules 

Control Panel of iVMS-4200: 
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Menu Bar: 

 

Client 
About Client 

Click to view the client version and view the 

manageable device quantity. 

Quit Client Click to exit the client. 

File 

Open Captured Picture 
Enter the Capture page to select the folder location of 

the exported captured picture file (s).  

Open Video File 

Enter the video player and select the folder location of 

the exported video file (s), You can also capture 

pictures during the playing of the video file.   

Open Log File 
Enter the Log File page to select the folder location of 

the exported log file (s) 

System 

Lock 
Lock screen operations. Log in the client again to 

unlock. 

Switch User Switch the login user. 

System Configuration Open the System Configuration page. 

Import Configuration File Import client configuration file from your computer. 

Export Configuration File Export client configuration file to your computer. 

View 

1024*768 Display the window at size of 1024*768 pixels. 

1280*1024 Display the window at size of 1280*1024 pixels. 

Most Adaptive Screen Display the window in most adaptive mode. 

Control Panel Enter Control Panel page. 

Main View Open Main View page. 

E-map Open E-map page. 

Event Search Open Event Search page. 

Remote Playback Open Remote Playback page. 

Tool 

Group Management Open the Group Management page.  

Camera Settings Open the Camera Setting page.  

Account Management Open the Account Management page. 

Device Management Open the Device Management page. 

Storage Server 

Management 
Open the Storage Server Management page. 

Stream Media Server 

Management 
Open the Stream Media Server Management page.  

Device Arming Control Set the arming status of devices. 

Help 

Open Wizard Open the guide for the client configuration. 

User Manual 
Click to open the User Manual; you can also open the 

User Manual by pressing F1 on your keyboard. 

 

The iVMS-4200 client software is composed of the following function modules: 

 

The Main View module provides live view of network cameras and video encoders, and 

supports some basic operations, such as picture capturing, recording, PTZ control, etc. 
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The E-map module provides the displaying and management of E-maps, hot regions and 

hot spots. 

 

The Event Search module provides searching and playing back the alarm video file of 

motion detection and alarm input. 

 
The Remote Playback module provides the search, playback, export of video files. 

 

The Group Management module provides adding, modifying, or deleting the camera 

groups, and importing/exporting cameras to the groups. 

 

The Log Search module provides the query of system log files and the log files can be 

filtered by different types. 

 

The Account Management module provides the adding, modifying, and deleting of user 

accounts and different permissions can be assigned for different users. 

 

The Device Management module provides the adding, modifying and deleting of 

different devices. 

 

The Storage Server Management module provides adding, modifying, or deleting the 

storage server. 

 

The Stream Media Server Management module provides adding, modifying, or deleting 

the stream media server. 

 

The Camera Settings module provides configuring camera parameters (e.g., image 

quality, recording schedule, motion detection, etc.).   

 

The System Configuration module provides the configuration of the general parameters 

(e.g., saving path of files, alarm sound, Email, etc.).  

The function modules are easily accessed by clicking the navigation buttons on the control panel or by 

selecting the function module from the View or Tool menu. 

1.4 Updates Instruction  

Multiple newly-designed functions are offered in the latest iVMS-4200 client software. You can get a 

brief view of the updates instruction from the following contents. 

 Add Device via Hik-Connect Domain 

Support adding device via Hik-Connect Domain. 

 View Online Status after Adding Device 

Support viewing the online status after adding devices. 

 Perform Live View and Playback in Full Screen Mode 

Support viewing live video and playing video files in full screen mode. 

 Customize Window Division for Live View and Playback 

Support setting a custom window division for live view and playback. 

 Auto-change Stream Type 

Support switching stream type automatically. 

 Encrypt for Email 

Support setting encryption for email. 

 Improve Security 

Encrypt the database sensitive information. 
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Chapter 2  User Registration and Login 

For the first time to use iVMS-4200 client software, you need to register a super user for login.  

Steps: 

1. Input the super user name and password.  

We highly recommend you to use a strong password to ensure your data security. 

2. Confirm the password.  

3. (Optional) Check Enable Auto-login checkbox to log in to the software automatically. 

4. Click Register.  

Then, you can log in to the software as the super user. 

 

 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length 

of the password cannot be less than 6 characters. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

 

When opening iVMS-4200 after registration, you can log in to the client software with the registered 

user name and password. 

Steps: 

1. Input the user name and password you registered. 

2. Optionally, check Enable Auto-login checkbox to log in to the software automatically. 

3. Click Login. 
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After running the client software, a wizard will open to guide you to add the device and do some 

basic settings.   

 

Click Enter Wizard to start the wizard and add the device, or click Cancel to exit the wizard. 
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Chapter 3  Device Management 

3.1 Adding the Device 

Purpose: 

After running the iVMS-4200, you can add the devices, including network cameras, DVRs, NVRs, etc., 

to the client for the remote configuration and management, such as live view, playback, alarm 

settings, etc.  

Perform the following steps to enter the Device Management page. 

Click  on the control panel, or click Tools->Device Management to open the Device 

Management page. 

 

3.1.1 Activating Device 

Purpose: 

For some devices, you are required to create the password to activate them before they can be 

added to the software and work properly. 

Note: This function should be supported by the device. 

Steps: 

1. Enter the Device Management page. 

2. In the device list, check the device status (shown on Security column) and select an inactive 

device. 

Or you can click Show Online Devices button to open the following page. 

All the online devices are displayed in the device list. 
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3. Select the inactive device. 

4. Click Activate to open the Activation page. 

5. Create a password in the password field, and confirm the password. 

 

STRONG PASSWORD RECOMMENDED– We highly recommend you create a strong password of 

your own choosing (using a minimum of 8 characters, including upper case letters, lower case 

letters, numbers, and special characters) in order to increase the security of your product. And 

we recommend you reset your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

 

6. Click OK to create the password for the device. 

A “The device is activated.” window pops up when the password is set successfully. 

After activating the device, the Safe Status of the device will turn to Active.  

In the Show Online Devices page, select the activated device and you can edit its network 

parameters. 

Note: This function is only available on the Show Online Devices window. You can change the device 

IP address to the same subnet with your computer if you need to add the device to the software. 

Steps: 

1. Change the device IP address to the same subnet with your computer by modifying the IP 

address manually. 

2. Edit the subnet mask and port No. according to the actual needs. 
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3. Input the password set in step 4 and click Modify to complete the network settings. 

3.1.2 Adding Online Devices 

Purpose: 

The active online devices in the same local subnet with the client software will be displayed in the 

Show Online Devices page. You can click the Refresh every 15s button to refresh the information of 

the online devices. 

Add Single Device 

Steps:  

1. Click Show Online Devices button to open Show Online Devices window.  

All the active online devices in the same local subnet with the client software will be displayed. 

2. Select one device. 

Note: For the inactive device, you need to create the password for it before you can add the 

device properly. For details, please refer to Chapter 3.1.1 Activating Device. 

3. Click Select Device, and click OK in the pop-up window to open Add Device window. 

 

4. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address. The IP address of the device is obtained automatically in 

this adding mode. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 
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5. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

6. Click Add to add the device. 

Add Multiple Devices 

Steps: 

1. Click Show Online Devices button to open Show Online Devices window.  

All the active online devices in the same local subnet with the client software will be displayed. 

2. Select devices you want to add. 

Note: For the inactive device, you need to create the password for it before you can add the 

device properly. For details, please refer to Chapter 3.1.1 Activating Device. 

3. Click Select Device, and click OK in the pop-up window to open Add Device window. 

 

4. Input the required information. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 

5. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

6. Click Add to add the devices. 

Modify Network Information 

In the Show Online Devices page, select the activated device and you can edit its network 

parameters in the Network Info area. 

Steps: 

1. Change the device IP address, subnet mask, and port No. according to the actual needs. 

2. Input the administrator password of the device. 

3. Click Modify to complete the network settings. 

Reset Device Password 
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You can reset the device password in the Show Online Devices page. 

According to the different devices, the software provides two different methods for restoring the 

default password or resetting the password. 

Select the device from the list, click Restore. 

Option 1: 

If the window with security code field pops up, input the security code, and then you can restore the 

default password of the selected device. 

Note: The security code is returned after you send the serial No. of the device to the manufacturer. 

Option 2: 

If the window with import file and export file buttons, password and confirm password field pops up, 

follow the steps below to reset the password: 

1. Click Export to save the device file on your PC. 

2. Send the file to our technical engineers. 

3. Our technical engineer will send you a file to you. 

Click Import button and select the file sent by the technical engineer and import it. 

4. Input new password in text fields of Password and Confirm Password. 

5. Click OK to reset the password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 

3.1.3 Adding Devices by IP or Domain Name 

Steps: 

1. In the Device Management page, click Add to open Add Device window. 

2. Select IP/Domain as the adding mode. 

 

3. Input the required information. 
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Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address or domain name. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 

4. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

5. Click Add to add the device. 

3.1.4 Adding Devices by Hik-Connect 

Purpose: 

You can add the devices which have been added to the Hik-Connect account to the client. 

Before you start: Add the devices to Hik-Connect account via Hik-Connect first. See the User Manual 

of Hik-Connect Mobile Client for details. 

Steps: 

1. In the Device Management page, click Add to open Add Device window. 

2. Select Hik-Connect as the adding mode. 

 

3. Select the country or region. 

4. Click Login to enter the Login page. 
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5. Input the Hik-Connect account and password. 

6. Click Login to log in to your account. 

All the devices added in this account will display.  

Note: The account information will keep 7 days. After 7 days, you are required to log in to the 

account again. 

 

7. Check the checkbox(es) to select the device(s). 

8. Input the user name and password of the selected device(s). 

9. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

10. Click Add to add the device(s). 

3.1.5 Adding Devices by IP Server 

Steps: 

1. In the Device Management page, click Add to open Add Device window. 

2. Select IP Server as the adding mode. 
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3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Server Address: Input the IP address of the PC that installs the IP Server. 

Device ID: Input the device ID registered on the IP Server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 

4. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

5. Click Add to add the device. 

3.1.6 Adding Devices by HiDDNS 

Steps: 

1. In the Device Management page, click Add to open Add Device window. 

2. Select HiDDNS as the adding mode. 
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3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Server Address: www.hik-online.com. 

Device Domain Name: Input the device domain name registered on HiDDNS server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and special 

characters) in order to increase the security of your product. And we recommend you reset your 

password regularly, especially in the high security system, resetting the password monthly or 

weekly can better protect your product. 

4. (Optional) Check Export to Group checkbox to create a group by the device name.  

All the channels of the device will be imported to the corresponding group by default. 

5. Click Add to add the device. 

3.2 Group Management 

Purpose: 

The encoding devices added should be organized into groups for a convenient management. You can 

get the live view, play the video files, and do some other operations of the device through the group. 

Before you start: 

Encoding devices need to be added to the client software for group management. 

 

Click  on the Control Panel, or you can click Tool -> Group Management to enter the Camera 

Group page as follows. 

http://www.hik-online.com/
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Adding Group 

Steps:  

1. Click Add on the Group List on the right to open the Add Group window. 

2. Input a group name as you want. 

3. Click OK to add the new group to the group list. 

 

Importing Camera to Group 

Steps: 

1. In the Select Device panel on the left, click to select the device and the thumbnails of the 

cameras of the device will be displayed below. 

Note: You can click Add Device to add a new device. For details, refer to Chapter 3.1 Adding the 

Device 

2. Select the thumbnails of the cameras.  

You can double-click the thumbnail of the camera to view the live video of the camera. 

3. Select a group from the group list. 

4. Click Import to import the selected cameras to the group. 

You can also click Import All to import all the cameras to the selected group. 

Note: Up to 64 cameras can be added to one group, and up to 1024 cameras for all the groups 

are allowed in total. 
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The following buttons are available on the Select Device panel: 

 Modify Modify the connection parameters of the device. 

 Delete Delete the device. 

 Refresh Refresh the latest information of added cameras. 

 Export to Group 
Create a group named as device name and import the 

device to group. 

 Remote Configuration Open the Remote Configuration window of the device. 

  Fold All/Expand All Collapse/Expand all the thumbnails of cameras. 

  Fold/Expand Collapse/Expand the thumbnails of camera. 

Modifying the Group/Camera 

After adding the group and importing the camera to the group, you can edit the group name and the 

imported camera name as desired. 

Steps: 

1. Select the group/camera from the group list on the right, and click Modify, 

or double-click the group/camera name to open Modify Group/Camera window. 

2. Edit the group/camera information, including the group/camera name, the stream type, etc. 

3. Click OK to save the new settings. 

  

Removing Cameras from the Group 

Steps: 

1. Click to select the imported camera from the group list. 

2. Click Delete to remove the camera from the group. 

Deleting the Group 

Steps: 

1. Select the group in the Group list on the right. 

2. Click Delete, and click OK in the pop-up window to confirm the deleting. 
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The selected group and the cameras under it will be deleted. 
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Chapter 4  Camera Settings 

Purpose: 

Before remote playback, you should set the schedule first.  

You can also configure the event (including motion detection alarm, tampering alarm, video loss) of 

the device. 

You can also configure the parameter for the image and video to get different performance for actual 

needs. 

Meanwhile, you can set the PTZ parameters and network connection parameters in this section. 

Click  on the control panel to enter the Camera Settings page.  

 

Select the camera on the dropdown list on left side of the page, and the video image of that camera 

will be displayed below.  

Click on icons in the lower left area to enter different configuration pages, such as the image settings 

page, the video quality setting page and so on.  

 
Video picture parameters configuration 

 
Video encoding quality configuration 

 
Recording schedule configuration 

 
Video display parameters configuration 

 
Motion detection configuration  

 
View tampering alarm configuration 

 
Video loss alarm configuration 
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PTZ configuration 

 

Network parameter configuration for the camera 

Note: You can click Device Settings to enter the Remote Configuration page of the device. For details, 

please refer to the user manual of the device. 

4.1 Picture Settings 

In Picture Settings page, you can adjust the brightness, contrast, saturation, and hue of the video 

image.  

Note: The available parameters may be different from the camera types. 

Drag the slider to adjust the level from lowest to highest.   

 

You can click Default to restore default settings. 

4.2 Video Settings 

Purpose: 

You can set video parameters, such as video quality, resolution, and other parameter settings. 

Steps: 

1. Click Video Settings to enter the Video Settings page. 

 

2. Set video parameters, including video resolution and video quality for main stream and sub 
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stream separately.  

You can click Advanced Settings to open Advanced Settings window and set the related 

parameters, such as stream type, bitrate type, and so on. 

 

3. Set the event parameters. 

1) Check Enable Event Parameters checkbox. 

2) Set the video quality and resolution for event video. 

3) (Optional) Click Advanced Settings to open Advanced Settings window and set the related 

parameters, such as stream type, bitrate type, and so on. 

4) Click OK to save the settings. 

4. Click Copy to to copy the settings to other cameras in the group. 

5. Click Save to save the settings. 

4.3 Schedule 

Purpose: 

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the 

remote storage server connected, you can set the recording schedule for the cameras for the 

continuous, alarm triggered, or command triggered recording. And the video files can be searched 

for the remote playback. 

Click Schedule to enter the recording schedule page. 
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4.3.1 Storing on the DVR, NVR, or Network Camera 

Purpose: 

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such 

as the HDDs, Net HDDs and SD/SDHC cards for video files. You can set a recording schedule or 

capture schedule for the channels of the local devices. 

Before you start: 

The newly installed storage devices need to be formatted. Go to the remote configuration page of 

the device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the 

selected storage device. 

Steps: 

1. Open the Schedule page in Camera Settings. 

2. Select the camera in the Camera Group dropdown list. 

3. Check Local Recording or Capture checkbox to enable device local recording or capture. 

4. Select the recording or capture schedule template from the drop-down list. 

 All-day Template: for all-day continuous recording. 

 Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM. 

 Alarm Template: for the alarm triggered recording. 

 Template 01 to 08: fixed templates for specific schedules. You can edit the templates if 

needed. 

 Customized: can be customized as desired. 

If you need to edit or customize the template, refer to Configuring Recording Schedule 

Template 

5. Click Advanced Settings to set the recording parameters.  
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Note: The displayed items vary with the devices. 

Parameters Descriptions 

Pre-record 
Normally used for the event triggered record, when you want to record before 

the event happens 

Post-record After the event finished, the video can also be recorded for a certain time. 

Video Expired Time 
The time for keeping the video files in the storage device, once exceeded, the 

files will be deleted. The files will be saved permanently if the value is set as 0. 

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD. 

Record Audio Record the video files with audio or not. 

6. (Optional) Click Copy to… to copy the recording schedule settings to other channels. 

 

7. Click Save to save the settings. 

Configuring Recording Schedule Template 

Perform the following steps to configure the recording schedule template: 

If Template 01 to 08 is selected from the drop-down list, start from step 1; 

If Customized is selected from the drop-down list, start from step 2. 

1. Click Edit to edit the template and select the template to be set. 

You can edit the template name. 

2. Set the time schedule for the selected template. 

 refers to normal schedule record. The schedule time bar is marked with . 

 refers to the schedule record for the event. The schedule time bar is marked with 

. 
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 refers to the schedule record triggered by command. The schedule time bar is 

marked with . 

Note: Recording triggered by command is only available for the ATM transactions when the ATM 

DVR is added to iVMS-4200. 

3. (Optional) After setting the time schedule, you can perform the following operations to adjust 

the time period. 

 When the cursor turns to , you can set the time period. 

 When the cursor turns to , you can move the selected time bar you just edited. You can 

also edit the displayed time point to set the accurate time period. 

 When the cursor turns to , you can lengthen or shorten the selected time bar. 

4. (Optional) Delete or copy the time schedule. 

Select the schedule time bar and click  to delete the selected time bar. 

Select the schedule time bar and click  to delete all the time bars. 

Select the schedule time bar and click  to copy the time bar settings to the other dates. 

5. Click Save to save the settings.  

Note: Up to 8 time periods can be set for each day in the recording schedule. 

 

4.3.2 Storing on Storage Server 

Purpose: 

You can add storage device to the client for storing the video files of the added encoding devices and 

you can search the files for remote playback. The storage device can be storage server, CVR (Center 

Video Recorder) or other NVR. Here we take the settings of storage server as an example. 

Before you start: 

The storage server application software needs to be installed on other PC running Windows OS. 

When installing the iVMS-4200, check Storage Server checkbox to enable the installation of storage 

server. 

Adding the Storage Server 

To assign a Storage Server for the recording schedule, add at least one storage server to the client. 

Steps: 

1. Click  on the desktop to run the storage server. 

Notes:  

 The Storage Server can only be installed on the PC running Windows OS. 
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 If the storage server port (value: 8000) is occupied by other service, a window will open. 

You should change the port No. to other value to ensure the proper running of the storage 

server. 

2. On the iVMS-4200 Client, click  on the control panel to enter the Storage Server 

Management page. 

You can also click Storage Server Management in Schedule page of Camera Settings to enter the 

Storage Server Management page. 

 

3. Click Add to add the storage server. 

You can add the storage server in the following ways: 

 By detecting the online storage server, refer to Chapter 3.1.2 Adding Online Devices. 

 By specifying the storage server IP address, refer to Chapter 3.1.3 Adding Devices by IP or 

Domain Name. 

 By IP Server, refer to Chapter 3.1.5 Adding Devices by IP Server. 

4. (Optional) Select the added server and click Modify to edit its information. 

You can click Delete to delete it. 

Formatting the HDDs 

Purpose: 

The HDDs of the storage server need to be formatted for the video file. 

Steps: 

1. Select the added storage server from the list and click Remote Configuration. 

2. Click HDD tab to enter the HDD Formatting page. 

3. Select the HDD from the list and click Format. 

You can check the formatting process from the process bar and the status of the formatted HDD 

changes from Unformatted to Normal Status. 

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the 

formatted HDDs will not be deleted. 
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Configuring Storage Schedule 

Before you start: 

The storage server needs to be added to the client software and the HDDs need to be formatted for 

the video file storage. 

Steps: 

1. Add the camera to the storage server first. 

(1) In the Storage Server Management page, select the added storage server and click Remote 

Configuration. 

(2) Click Camera tab to enter the following page. 

 

(3) Click Add and select a camera from the group to add the camera to the storage server.  

(4) (Optional) Select the added camera and click Delete to delete the camera from the storage 

server.  

(5) Click Save to save the settings. 

2. Configure the recording schedule for the added cameras. 
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(1) In the Remote Configuration page, click Schedule tab to enter the following page. 

 

(2) Select the added camera from the dropdown list. 

(3) Select one recording schedule. 

 All-day Template: for all-day continuous recording. 

 Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM. 

 Alarm Template: for the alarm triggered recording. 

 Template 01 to 08: fixed templates for specific schedules. You can edit the templates if 

needed. 

 Customized: can be customized as desired. 

If you need to edit or customize the template, refer to Configuring Recording 

Schedule Template 

After adding the camera to the storage server and setting the recording schedule, the recording 

schedule on storage server function will be enabled. 

Notes:   

 To change the recording resolution, bit rate or other recording parameters, please refer to 

Chapter 4.1 Picture Settings. 

 To ensure that event recording works properly, please set motion detection and video 

tampering area and arming schedule first. For details, refer to Chapter 4.5 Motion Detection and 

Chapter 4.6 Tampering Alarm. 

4.4 Video Display 

The Display menu allows you to configure the display settings for the camera, including:   

 Display Name: the camera name displayed on the live video.  

 Display Date: the date displayed on the live video.  

 Display Week: Display the week on the live video. 

 Enable Privacy Mask: Enable privacy mask function on the live video. 

 Text Overlay: Edit user-defined text to be displayed on the live video.   
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Steps: 

1. Click Video Display to enter the video display settings page. 

2. Check the checkboxes to display the name, date, or week to the video image. 

3. Set the OSD Attribute. 

4. (Optional) Click Copy to… and select other cameras to copy the video display settings to other 

cameras. 

5. Display privacy mask on the video image. 

1) Check Enable Privacy Mask checkbox. 

2) Select Draw Privacy Mask Area option from the drop-down list. 

3) Drag your cursor to draw a rectangle as privacy mask. 

 

You can click  to remove the selected privacy mask area, or click  to clear all privacy 

mask areas on the live video. 

Note: Up to four privacy mask areas can be configured.  

6. Set the text overlay. 

1) Check the checkbox in the Text Overlay. 

2) Input the text content.  

7. Configure the OSD location and the privacy mask location & size on the video image.  

1) Select Insert OSD/Camera Name/Text option from the drop-down list. 
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2) Move the OSD to the desired location on the video image.  

 
8. Click Save to save the settings.  

4.5 Motion Detection  

Purpose: 

A motion detection alarm is triggered when the client software detects motion within its defined 

area. The linkage actions, including alarm output, channel record and client action can be set. 

Note: The configuration varies according to different devices. For details, please refer to the user 

manual of the devices. 

Steps: 

1. Click Motion Detection to enter the motion detection alarm settings page. 

2. Check Enable Motion Detection checkbox. 

3. Select the arming schedule template from the drop-down list. 

 All-day Template: For all-day continuous arming. 

 Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM. 

 Template 01 to 09: Fixed templates for special schedules. You can edit the templates if 

needed. 

 Customized: Can be customized as desired. 

If you need to edit or customize the template, see Configuring Arming Schedule 

Template 

4. Drag the mouse on the live video image to draw a defined area for the arming region. 

You can click  to set the whole video area as detection area, or click  to clear all the 

detection area. 

5. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the 

value is, the more sensitive the detection is. 

6. Check the checkboxes to activate the linkage actions.  

Linkage Actions Descriptions 

Audible Warning 

The client software gives an audible warning when alarm is triggered. You can 

select the alarm sound for audible warning. For setting the alarm sound, 

please refer to Chapter 10.2.4 Alarm Sound Settings. 

Email Linkage Send an email notification of the alarm information to one or more receivers. 
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For setting the email parameters, refer to Chapter 10.2.5 Email Settings. 

Notify Surveillance 

Center 

Upload alarm information to the client software when motion detection is 

triggered. 

Full Screen 

Monitoring 
Switch to full screen to monitor the motion detection video. 

Upload Captured 

Picture to FTP 

When motion alarm is triggered, pictures will be captured and uploaded to 

FTP server. 

Tigger Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Triggered Camera Start the recording of the selected cameras when alarm is triggered. 

7. Click Save to save the settings.  

 

Configuring Arming Schedule Template 

Perform the following steps to configure the arming schedule template: 

If Template 01 to 09 is selected in the drop-down list, start from step 1; 

If Custom is selected in the drop-down list, start from step 2. 

Steps: 

1. Click Edit to enter the Templates Management page. Select the template to be set and you can 

edit the template name. 

2. Set the time schedule for the selected template. 

When the cursor turns to , you can set the time period. 

When the cursor turns to , you can move the selected time bar you just edited. You can 

also edit the displayed time point to set the accurate time period. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click  to delete the selected time bar, 

or click  to delete all the time bars, 

or click  to copy the time bar settings to the other dates. 

4. Click OK to save the settings. 
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Note: Up to 8 time periods can be set for each day in the arming schedule template. 

 

 

4.6 Tampering Alarm 

Purpose: 

A video tampering alarm is triggered when the camera is covered and the monitoring area cannot be 

viewed. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Click Tampering Alarm to enter the tempering alarm settings page. 

2. Check Enable Tampering Alarm checkbox. 

3. Select the arming schedule template from the drop-down list. 

 All-day Template: For all-day continuous arming. 

 Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM. 

 Template 01 to 09: Fixed templates for special schedules. You can edit the templates if 

needed. 

 Customized: Can be customized as desired. 

If you need to edit or customize the template, see Configuring Arming Schedule 

Template 
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4. Drag the mouse on the live video image to draw a defined area for the arming region. 

You can click  to set the whole video area as detection area, or click  to clear all the 

detection area. 

5. Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity. The larger the 

value is, the more sensitive the detection is. 

6. Check the checkboxes to activate the linkage actions.  

Linkage Actions Descriptions 

Audible Warning 

The client software gives an audible warning when alarm is triggered. You can 

select the alarm sound for audible warning. For setting the alarm sound, 

please refer to Chapter 10.2.4 Alarm Sound Settings. 

Email Linkage 
Send an email notification of the alarm information to one or more receivers. 

For setting the email parameters, refer to Chapter 10.2.5 Email Settings. 

Notify Surveillance 

Center 

Upload alarm information to the client software when motion detection is 

triggered. 

Full Screen 

Monitoring 
Switch to full screen to monitor the motion detection video. 

Tigger Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

7. Click Save to save the settings.  

 

4.7 Video Loss 

Purpose: 

When the client software cannot receive video signal from the front-end devices, the video loss 

alarm will be triggered. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Click Video Loss to enter the video loss alarm settings page. 
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2. Check Enable Video Loss Detection checkbox. 

3. Click the arming schedule and select the arming schedule template. 

 All-day Template: For all-day continuous arming. 

 Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM. 

 Template 01 to 09: Fixed templates for special schedules. You can edit the templates if 

needed. 

 Customized: Can be customized as desired. 

If you need to edit or customize the template, see Configuring Arming Schedule 

Template 

4. Check the checkboxes to activate the linkage actions.  

Linkage Actions Descriptions 

Audible Warning 

The client software gives an audible warning when alarm is triggered. You can 

select the alarm sound for audible warning. For setting the alarm sound, 

please refer to Chapter 10.2.4 Alarm Sound Settings. 

Email Linkage 
Send an email notification of the alarm information to one or more receivers. 

For setting the email parameters, refer to Chapter 10.2.5 Email Settings. 

Notify Surveillance 

Center 

Upload alarm information to the client software when motion detection is 

triggered. 

Full Screen 

Monitoring 
Switch to full screen to monitor the motion detection video. 

Tigger Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

5. Click Save to save the settings.  
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4.8 PTZ Control 

Purpose: 

In the PTZ Control configuration page, you can specific the PTZ connection parameters, such as baud 

rate, data bits, stop bits, parity, and so on.  

Steps: 

1. Click PTZ Control to enter the PTZ control configuration page. 

 
2. Set the PTZ parameters, such as baud rate, data bits, stop bits, parity, flow control, PTZ protocol, 

and PTZ address. 

Note: All these PTZ parameters should be consistent with the local settings on the PTZ to ensure 

valid PTZ control. 

3. (Optional) Click Copy to… to copy all the PTZ settings to other cameras. 

4. Click Save to save the settings. 

4.9 Network Connection 

In the Network Connection configuration page, you can specify the protocol and select the stream 

type of the camera. You can also configure stream media server.  

4.9.1 Network Parameter Settings 

Steps: 

1. Click Network Connection to enter the Network Connection configuration page. 
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2. Set the protocol as TCP, UDP, MCAST, or RTP. 

3. Select Main Stream or Sub-Stream as the stream type of the camera. 

Note: The stream type settings will take effect after start live view again. You can also set the 

stream type in Main View module. For details, refer to Chapter 5 Live View. 

4. Check Get Video Stream via Stream Media Server checkbox to enable the stream media server. 

Note: You should add the stream media server first. For details, refer to Chapter 4.9.1 Network 

Parameter Settings. 

5. Select the stream media server. 

6. (Optional) Click Copy to… to copy all the network connection settings to other cameras. 

7. Click Save to save the settings. 

4.9.2 Stream Media Server Management 

Purpose: 

There is always a limit of the device remote access number. When there are many users wanting to 

get remote access to the device to get the live view, you can add the stream media server and get 

the video data stream from the stream media server, thus to lower the load of the device. 

Adding the Stream Media Server 

Before you start: 

The stream media server application software needs to be installed on other PC running Windows OS. 

When installing the iVMS-4200, check Stream Media Server checkbox to enable the installation of 

stream media server. 

Steps: 

1. Click  on the desktop to run the stream media server. 

Notes:  

 The Stream Media Server can only be installed on the PC running Windows OS. 

 If the stream media server port (value: 554) is occupied by other service, a dialog will open. 

You should change the port No. to other value to ensure the proper running of the stream 

media server. 

2. On the iVMS-4200 Client, click  to open the Stream Media Server Management page. 

Or you can click Stream Media Server on Network Connection page of Camera Settings to enter 

the Stream Media Server Management page. 
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3. Click Add to open the following page. 

 

4. Input the required information, including nickname, IP address, and port. 

Note: The default port value is 554. 

5. Click Add to add the stream media server to the client software. 

Note: For one client, up to 16 stream media servers can be added. 

After adding the stream media server, you can perform the following operations. 

 Select the stream media server and click Modify to edit its information. 

 Select the stream server and click Delete to delete it. 

Adding Cameras to Stream Media Server to Forward Video Stream  

Purpose: 

To get the video stream of a camera via stream media server, you need to connect the camera to the 

stream media server. 

Steps: 

1. Select the stream media server from the list.  

2. Click Remote Configuration to enter the Stream Media Server Settings page. 

3. Click Channel Configuration tab. 

4. Select the camera group and select cameras of which the video stream is to be forwarded via 

the stream media server. 

5. Click OK to save the new settings. 
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6. Go the Main View page and start the live view of the cameras again. You can check the channel 

number of the video stream forwarded through or sent from the stream media server. 

Notes:  

 For one stream media server, up to 64 channels of video stream can be forwarded through it 

and up to 200 channels of video stream can be sent to clients from it. 

 If the camera is offline, the client can still get the live video via the stream media server. 
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Chapter 5  Live View 

Purpose: 

For the surveillance task, you can view the live video of the added network cameras, video encoders 

and video intercom device on the Main View page. And some basic operations are supported, 

including picture capturing, manual recording, PTZ control, etc. 

Before you start: 

A camera group is required to be defined for live view. 

 

Click  on the control panel, or click View->Main View to open the Main View page. 

 

 

Main View Page 

1   Camera List 

2   Display Window of Live View 

3   Live View Toolbar 

 

Camera Status: 

 The camera is online and works properly. 

 The camera is in live view. 

 The camera is in recording status. 

 The camera is offline. 

 

Live View Toolbar: 

 

On the Main View page, the following toolbar buttons are available: 

  Full Screen Display the live view in full screen mode. Press ESC to exit. 

 Window Division Set the window division. 
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  Start/Stop Start or stop the live view of all cameras. 

 Capture Capture the current image of the camera. 

 Start Recording 
Start manual recording for the corresponding cameras, click again to 

stop. 

 Previous Go for live view of the previous page. 

 Next Go for live view of the next page. 

  
Start/Stop 

Auto-switch 
Click to resume/pause the auto-switch in live view. 

 Show/Hide Menu Show/Hide the configuration menu of auto-switch. Click again to hide. 

  Volume Turn off/on the audio in live view and you can adjust the volume. 

 

Right-click on the display window in live view to open the Live View Management Menu: 

 
The following buttons are available on the right-click Live View Management Menu: 

 Capture Capture the picture in the live view process. 

  Start/Stop Recording Start/Stop the manual recording. The video file is stored in the PC. 

 PTZ Control Enable PTZ control function on the display window. 

 Digital Zoom 
Enable the digital zoom function. Click again to disable the 

function. 

 Camera Status 
Display the status of the camera in live view, including the 

recording status, signal status, connection number, etc. 

 Camera Settings 
Open the Camera Settings page of the camera. Refer to Chapter 4 

Camera Settings. 

 Synchronization 
Sync the camera in live view with the PC running the client 

software. 

  Audio On/Mute Click to enable/disable the audio in live view. 

 Stop Live View Stop the live view in the display window. 

 Fisheye Expansion 
Enter the fisheye expansion mode. Only available when the device 

is fisheye camera.  

 
Switch to Instant 

Playback 
Switch to Instant playback mode. 

  Full Screen Display the live view in full screen mode. Press ESC to exit. 
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5.1 Starting and Stopping the Live View 

Starting Live View for One Camera 

Steps: 

1. Open the Main View page. 

2. (Optional) Click  in live view toolbar to select the window division mode for live view. 

3. Drag the camera to the display window, 

or double-click the camera name after selecting the display window to start the live view. 

Note: You can drag the video of the camera in live view to another display window if needed. 

4. (Optional) In the device list on the left, you can right-click on the camera group name, or on the 

camera name to open the right-click menu. 

  

For camera group, you can check to expand or fold all the cameras display in the group. And you 

can also switch the stream between main stream and sub stream for all the cameras in the 

group. 

For camera, you can click to view the camera status, to enter the camera settings page to 

configure the camera, and sync the camera time with the PC. And you can also switch the 

stream between main stream and sub stream. 

Note: The stream settings will take effect after starting live view again. 

Starting Live View for Camera Group 

Steps: 

1. Open the Main View page. 

2. Drag the group to the display window, 

or double-click the group name to start the live view. 

Note: The display window number is self-adaptive to the camera number of the group. 

Stopping the Live View 

Steps: 

1. Select the display window. 

2. Click Stop Live View on the right-click menu to stop the live view of the display window. 

You can also click  in live view toolbar to stop all the live view. 

5.2 Auto-switch in Live View 

Purpose: 

The video stream of the cameras from the same group will switch automatically in a selected display 
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window in camera auto-switch.  

Steps: 

1. Open the Main View page. 

2. Select a display window for camera auto-switch. 

3. Click  in the toolbar and select the auto-switch in single screen or multiple screens. 

Set the switching interval for the auto-switch. 

 

4. Select a group, and select the window for auto switch. 

5. Click  on the toolbar to start the camera auto-switch. 

6. Click  or  to view the live video of previous or next camera. 

5.3 PTZ Control in Live View  

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the 

preset, patrol and pattern for the cameras on the PTZ Control panel. And you can also open window 

PTZ control for the operations of PTZ cameras. 

Note: The PTZ Control function should be supported by the device. 

Right-click on the live view window, and click PTZ Control to open the PTZ Control panel. 

 
 

The following buttons are available on the PTZ Control panel: 

 Zoom 

 Focus 

 Iris 
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 3D Positioning 

 Light 

 Wiper 

 
Directional buttons, click  to start/stop auto-scan. 

 Speed adjustment for PTZ function 

5.3.1 Configuring the Preset 

Purpose: 

A preset is a predefined image position which contains information of pan, tilt, focus and other 

parameters. 

Steps: 

1. Click Preset tab to enter the PTZ preset configuration panel. 

2. Click the direction buttons and other buttons on the PTZ control panel to steer the camera to 

the desired view. 

3. Select a PTZ preset number from the preset list and click . 

 

4. Input the name of the preset in the pop-up window. 

5. Click OK to save the settings. 

 

To call a configured preset, double-click the preset, or select the preset and click . 

You also perform the following steps to call the preset. 

Steps: 

1. Click to select a live view window. 

2. For preset 1 to 9, click the corresponding number key (e.g., 4) to call the preset. 

For other presets, click “[”, number keys (e.g., 124), and “]” to call the preset. 

To modify a configured preset, select the preset from the list and click . 

To delete a configured preset, select the preset from the list and click .  

5.3.2 Configuring the Pattern 

Purpose: 

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions. 

Steps: 

1. Click Pattern tab to enter the PTZ pattern configuration panel. 
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2. Click  to start recording of this pattern path. 

3. Use the direction buttons to control the PTZ movement. 

4. Click  to stop and save the pattern recording.  

5. Click  to call the pattern.  

To stop calling the pattern, click . 

5.3.3 Configuring the Patrol 

Purpose: 

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable. 

Before you start: 

Two or more presets for one PTZ camera need to be added. 

Steps: 

1. Click Patrol tab to enter the PTZ patrol configuration panel. 

 

2. Select a path number from the drop-down list. 

3. Click  to add a preset, and set the dwell time and patrol speed for the preset. 

 

4. Repeat the above operation to add other presets to the patrol. 
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5. Optionally, you can click  or  to edit or delete a preset in the patrol path. 

6. Click  to call the patrol.  

To stop calling the patrol, click . 

Note: The preset dwell time can be set to 1 to 30 sec, and the patrol speed can be set to level 1 to 

40. 

5.4 Local Recording and Capture 

5.4.1 Manual Recording in Live View 

Purpose: 

Manual Recording function allows you to record the live video on the Main View page manually and 

the video files are stored in the local PC. 

Steps: 

1. Select the live view window, and click  on the toolbar,  

or right-click on the live view window and select Start Recording to start the manual recording. 

The icon  on the right-click menu turns to . 

2. Click  on the toolbar again,  

or click Stop Recording on the right-click menu to stop the manual recording. 

A prompt with the saving path of the video files you just recorded will open if all the operations 

succeed. 

Note: The saving path of video files can be set on the System Configuration page. For details, refer to 

Chapter 10.2.3 File Saving Path Settings. 

5.4.2 Viewing Local Video Files  

Steps: 

1. In the Main View page, click All Files(s) under the device to view all the recorded video files of 

the device. 
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2. Select the camera to be searched from the Camera list. 

3. Click  to specify the start time and end time for search. 

4. Click Search.  

The video files recorded locally between the start time and end time will display. 

The following buttons are available at the bottom of the page for each video file. 

 

 Select the video file, and click Delete. You can delete the video file. 

 Select the video file, and click Email Linkage. You can send an Email notification with the 

selected video file attached. 

Note: To send an Email notification, you should set the Email settings before proceeding. For 

details, refer to Chapter 10.2.5 Email Settings. 

 Select the video file, and click Save as. You can save a new copy of the video file. 

Double-click the video file and the video file can be played locally. 

 

The following buttons are available on the local playback page: 

  CIF/4CIF Display the video in cif/4cif resolution. 
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 Close Close the local playback page of the video files. 

  Pause/Play Pause/start the playback of the video files. 

 Stop Stop the playback of the video files. 

  Speed Down/Up Set the playback speed.  

 Single Frame Play back the video files frame by frame. 

 Digital Zoom Enable the digital zoom function. Click again to disable. 

  Audio On/Mute Click to enable/disable the audio in the local playback. 

 Capture Capture the picture in the playback process. 

5.4.3 Capturing Picture in Live View 

Select the live view window, and click  in the toolbar, or right-click on the live view window and 

select Capture to capture the current image of the live view window.  

A small window of the captured picture will display to notify whether the capturing operation is 

done or not.  

Note: The saving path of the captured pictures can be set on the System Configuration page. For 

details, refer to Chapter 10.2.3 File Saving Path Settings. 

5.4.4 Viewing Captured Pictures 

Purpose: 

The pictures captured in live view are stored in the PC running the software. You can view the 

captured pictures if needed. 

Steps: 

1. In the Main View page, click Picture under the device to view all the captured pictures of the 

device. 

 

2. Select the camera to be searched from the Camera list. 

3. Click  to specify the start time and end time for the search. 

4. Click Search.  

The pictures captured between the start time and end time will be displayed. 

5. Double-click the captured picture to enlarge it for a better view. 
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The following three buttons are available at the bottom of the page for each picture. 

 

 Select the captured picture, and click Delete. You can delete the selected picture. 

 Select the captured picture, and click Email Linkage. You can send an Email notification with the 

selected picture attached. 

 Select the captured picture, and click Save as. You can save a new copy of the selected picture. 

5.5 Instant Playback 

Purpose: 

The video files can be played instantly on the Main View page. Instant playback shows a piece of the 

video which was remarkable, or which was unclear on the first sight. Thus, you can get an immediate 

review if needed. 

Note: You can set the pre-play time for instant playback in System Configuration. By default, it is 3 

minutes. For configuring the pre-play time, refer to Chapter 10.2.1 General Settings. 

Before you start: 

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on 

the DVRs, NVRs, Network Cameras, etc., or on the storage servers. 

Steps: 

1. Start the live view. 

2. Right-click on the window to show the Live View Management menu. 

3. Click Switch to Instant Playback to switch to instant playback mode. 

A simple timeline will appear near the live view toolbar. Move the mouse to the simple timeline 

and a complete timeline will appear as follows: 

 

4. Drag the timeline at the bottom to adjust the playback progress. You can also click  or  

to scale up or down the time bar to choose a more accurate playback time. 

5. Right-click on the playback window and click Live View to stop the instant playback and go back 

for the live view. 

 

During instant playback, right-click on the display window to open the Instant Playback Management 

Menu: 

  
The following buttons are available on the right-click Instant Playback Management Menu: 
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  Pause/Resume Pause/start the instant playback in the display window. 

 Stop Stop the instant playback and return to the live view mode. 

 
Fast Forward/Slow 

Forward 
Increase/decrease the play speed of the instant playback. 

 Single Frame  Play back the video file frame by frame. 

 Add Default Tag Add a default tag to the current timeline of the video file. 

 Add Custom Tag 
Add a custom tag to the current timeline of the video file and you 

can set the tag name. 

 Tag Download Download the files by added tags. 

 Capture Capture the picture in the instant playback process. 

 

 
Start/Stop Recording Start/Stop clipping the video files. 

  Audio On/Mute Click to turn on/off the audio in instant playback. 

 Switch to Live View Switch to live view mode.  

5.6 Custom Window Division 

Purpose: 

The client software provides multiple kinds of pre-defined window division. You can also set custom 

window division as desired. 

Steps: 

1. Click  on the live view toolbar and select Edit to open Edit Custom Window Division 

window. 

 

2. Click Add to open Add Custom Window Division window. 

Note: Up to 5 custom window divisions can be added. 

3. Set a name for the new window division as desired. 

4. Click OK to save the settings. 

5. Drag your mouse to select the adjacent windows, and click Joint to joint them as a whole 

window. You can also click Cancel to cancel the jointing. 

6. Click Save to confirm the settings. 

7. Click  to back to the Main View page.  

Then you can click  and select the custom window division for playing live video. 
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Notes: 

 You can also enter the Remote Playback page and perform the steps above to configure 

the custom window division. 

 For remote playback, up to 16 windows can be played at the same time. The custom 

window division with more than 16 windows is invalid for playback. 

5.7 Live View in Fisheye Mode 

Purpose: 

You can play the live video of the camera in fisheye expansion mode. 

Note: The Fisheye Expansion is suitable for the fisheye camera. If you enable Fisheye Expansion for 

other cameras, the image may be distorted. 

Steps: 

1. Start the live view (refer to Chapter 5.1 Starting and Stopping the Live View). 

2. Right-click on the video and select Fisheye Expansion to enter the Fisheye Expansion window.  

3. Select the mounting type of the fisheye camera according to the actual mounting position. 

4. You can select the expanding mode for live view as desired. 

Note: For some devices, you can select the mounting type of the device and the related 

expanding mode will be listed. 

 

 Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed. 

This view mode is called Fisheye because it approximates the vision of a fish’s convex eye. 

The lens produces curvilinear images of a large area, while distorting the perspective and 

angles of objects in the image. 

 Panorama/Dual-180
o 

Panorama/360
o
 Panorama: In the Panorama view mode, the 

distorted fisheye image is transformed to normal perspective image by some calibration 

methods. 

 PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or 

Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ. 

Notes:  
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 Each PTZ view is marked on the Fisheye view and Panorama view with a specific 

navigation. You can drag the navigation on the Fisheye view or Panorama view to 

adjust the PTZ view, or drag the PTZ view to adjust the view to the desired angle. 

 The navigation will be hidden after 5 seconds of inactivity. 

 

 

PTZ Control 
In PTZ mode, you can use the PTZ control to adjust the PTZ window. 

Note: The PTZ panel varies according to different devices. 

 Select a PTZ window, and click one of the direction buttons to adjust the view angle. 

Note: Click-and-drag the No. label in the fisheye or panorama window will change the view 

angle of the PTZ window as well. 

 Select a PTZ window, and click  to start auto-scan, and click it again to stop auto-scan. 

 : Drag the slider to adjust the speed for PTZ movement. 

 : Zoom in or zoom out the selected PTZ window by clicking  or . Or you can 

scroll the mouse wheel to zoom in or zoom out. 

Preset 
Note: The preset is only supported by specific fisheye camera. 

Purpose: 

A preset is a user-defined monitor position/point. You can simply call the preset No. to change the 

monitor scene to the defined position.  

Steps: 

1. Click Preset tab to enter the preset configuration page. 

2. Select a PTZ window, and adjust the scene to the place you want to mark as a preset. 

3. Click , input the preset name, and click OK to save a preset. 

4. (Optional) Click  to call the configured preset. 

5. (Optional) Click  to delete the configured preset. 

Note: Up to 256 presets can be configured. 

Patrol 
Note: The patrol is only supported by specific fisheye camera. 

Purpose: 
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A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable.  

Before you start: 

At least 2 presets have to be configured before you configure the patrol. 

Steps: 

1. Click Patrol tab to enter the patrol configuration page. 

2. Select a patrol No. from the drop-down list. 

3. Click  to add the configured presets, and set the dwell time and patrol speed for the preset. 

Notes: 

 The dwell time ranges from 1 to 30s. 

 The patrol speed ranges from 1 to 40. 

 

4. Repeat the above operation to add other presets to the patrol. 

5. Click  to start the patrol, and click  to stop patrol. 

6. Optionally, you can click  or  to edit or delete a preset in the patrol path. 

Note: Up to 32 patrols can be set. 

5.8 Other Functions in Live View 

There are some other functions supported in the live view, including digital zoom, camera status and 

synchronization. 

Digital Zoom 

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then 

the rectangle area will zoom in/out. You can also use the mouse wheel for zooming in or restoring of 

the video in digital zoom mode. 

Camera Status 

The camera status, such as recording status, signal status, connection number, etc., can be detected 

and displayed for check. The status information refreshes every 10 seconds.  

Synchronization 

The synchronization function provides a way to synchronize the device clock with the PC which runs 

the client software.  
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Chapter 6  Remote Playback 

Purpose: 

The video files stored on the local device or the storage server can be searched by camera or 

triggering event, and then can be played remotely. 

Before you start: 

You should set the recording schedule first so that the videos will be recorded and can be played. For 

setting the recording schedule, refer to Chapter 4.3 Schedule. 

6.1 Normal Playback 

Purpose: 

The video files can be searched by camera or group name for the Normal Playback. 

Click  on the control panel, or click View->Remote Playback to open the Remote Playback page. 

 

Remote Playback Page 

1  Camera List 

2  Search Condition 

3  Calendars 

4  Display Window of Playback 

5  Playback Control Buttons 

6  Timeline 

6.1.1 Searching Video Files 

Steps: 

1. Open the Remote Playback page. 

2. In the camera list, check to select the cameras for playback. 
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Note: Up to 16 cameras can be searched simultaneously. 

3. In the File Type dropdown list, you can select the file type to narrow down the search scope and 

search for only the video files for certain types. 

4. In the calendar panel, select the date you want to search. 

Note: If there are video files for that camera in that day, the date which has video files will be 

marked with . 

5. Click Search to search the video files and the playback will start. 

Or you can select the date in the calendar panel and drag the camera to the display window to 

play the video files of the single camera. 

6.1.2 Playing Video Files 

After searching the video files for the normal playback, the playback will start in the display window. 

The timeline indicates the time duration for the video file. 

 

Click on the timeline to play back the video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can click  or  on the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

 

Normal Playback Toolbar: 

 

On the Normal Playback page, the following toolbar buttons are available: 

  Pause/Play 
Pause/start the playback of the video files of the selected 

camera. 

 Stop  Stop the playback of the selected camera. 

  
Slow Forward/Fast 

Forward 
Decrease/Increase the play speed of the playback. 

 Single Frame 
Play back the video files frame by frame. You can also scroll 

down the mouse wheel to play the video file frame by frame. 

 Window Division Set the window division. 

 Stop All Stop playback of all cameras. 

  Full Screen 
Display the video playback in full-screen mode. Press ESC to 

exit. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 

Right-click on the display window in playback to open the Playback Management Menu: 
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The following items are available on the right-click Playback Management Menu: 

 Play Start the playback. 

 Pause Pause the playback. 

 Stop Stop the playback. 

 Slow Forward Play the video file at a slower speed. 

 Fast Forward Play the video file at a faster speed. 

 Digital Zoom 
Enable the digital zoom function. Click again to disable the 

function. 

  Tag Control 

You can add tag for the video file to mark the important video 

point. 

Add Default Tag: Add tag and the default tag name is TAG.  

Add Custom Tag: Add the tag and you can customize the tag 

name. 

Edit Tag: You can view all the added tags, edit the tag name as 

desired, delete the added tag, and play back the video from the 

tag. 

 VCA Search 
Search the VCA event during playback. For details, refer to 

Chapter 6.5 VCA Playback 

 Capture Capture the picture in the playback process. 

 Start/Stop Recording Start/Stop the manual recording. The video file is stored in the PC. 

 Download 
Download the video files of the camera and the video files are 

stored in the PC. You can select to download by file or by date. 

 Enable/Disable Audio Click to enable/disable the audio in playback. 

 Fisheye Expansion 
Enter the fisheye playback mode. For details, please refer to 

Chapter 6.6 Fisheye Playback. 

  Full Screen Display the playback in full-screen mode. Press Esc key to exit. 

6.1.3 Downloading Video Files 

During playback, you can click Download on the right-click menu to download the video files of the 

camera to the local PC. You can select to download by file, by date, or by tag. 
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Download by Files 

Steps: 

1. Click Download by Files tab in the File Download page. You can view the video files information 

of selected camera. 

2. Check the checkbox of the video file and the total size of the selected files will be shown below. 

3. Click Download to start downloading the file to the local PC.  

You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed. 

4. Optionally, you can click Stop to stop downloading manually.  

 

Download by Date 

Steps: 

1. Click Download by Date tab in the File Download page.  

2. Check the checkbox of the time duration to enable it, and click  to set the start and end time. 

3. Click Download to start downloading the file to the local PC. The progress bar shows the 

downloading process. 

You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed. 

4. Optionally, you can click Stop to stop downloading manually.  
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Download by Tag 

Steps: 

1. Click Download by Tag tab in the File Download page. The added tags will be displayed. 

2. Check the checkbox of the tag and the total size of the selected files will be shown below. 

3. Click Download to start downloading the selected file (30 seconds before the selected tag to 30 

seconds after the tag) to the local PC. You can input the flow (0 to 32768 kbps) and click Set to 

control the downloading speed. 

4. Optionally, you can click Stop to stop downloading manually.  

 

6.2 Event Playback 

Purpose: 

The recordings triggered by event, such as motion detection and alarm input, can be searched for 
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Event Playback and this function requires the support of the connected device. 

Notes:  

 Event playback function is only available for NVR/DVR which support event recording. 

 Please import all the cameras to the group in Group Management page before search. 

 It is also required to enable continuous recording on all the alarm/motion-triggered channels 

before event playback. 

 

Click  on the control panel,  

or click View -> Event Search to enter the Event Search page. 

 

Steps: 

1. Select an event type: Motion Detection or Alarm Input. 

2. Select a camera group and select the camera or alarm input in the group to search. 

3. Click  to set the start time and end time for the search. 

4. Click Search to start search.  

All the video files that matching the search conditions will display in the Search Results panel. 

5. Click to select a display window and then double-click the video file in the Search Result panel to 

start playing the file. 

A simple timeline will appear near the playback toolbar. Move the mouse to the simple timeline 

and a complete timeline will appear as follows: 

 

6. Drag the timeline at the bottom to adjust the playback progress. You can also click  or  

to scale up or scale down the timeline bar to choose a more accurate playback time. 

 

The following icons are available on the playback toolbar in the Event Search page. 

 

 Play Start playing the video file. 

 Pause Pause playing the video file. 
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 Stop Stop playing all the video files. 

 Single Frame Play Play the video file frame by frame. 

 Playback Speed Change playback speed 

  Volume 
Turn off/on the audio in live view and you can adjust the 

volume. 

 

During playback, you can right-click to get the Event Playback Management menu as below.  

  

 Capture Capture the picture in the playback process. 

 Start/Stop Recording Start/Stop the manual recording. The video file is stored in the PC. 

 Download 
Download the video files of the camera and the video files are 

stored in the PC. You can select to download by file or by date. 

 Audio On/Mute Click to enable/disable the audio in playback. 

 Select Camera Select a recording-triggered channel for playback 

6.3 ATM Playback 

Purpose: 

Search the video files for ATM DVR. 

Note: This function should be supported by the device and the device should be configured with 

transaction rules. For details, please refer to the user manual of the device. 

Click  on the control panel, or click View->Remote Playback to open the Remote Playback page. 

6.3.1 Searching Video Files for ATM Playback 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera of the ATM DVR. 

3. Check By Card Number checkbox and input the card number that is contained in the ATM 

information. 

4. In the File Type dropdown list, you can select the file type to narrow down the search scope and 

search for only the video files for certain types. 

5. In the calendar panel, click to select date you want to search. 

Note: If there are video files for that camera in that day, the date which has video files will be 

marked with . 

6. Click Search to search the video files and the playback will start. 
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6.3.2 Playing Video Files for ATM Playback 

After searching the video files for the normal playback, the playback will start in the display window. 

The timeline indicates the time duration for the video file. 

 

Click on the timeline to play back the video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can click  or  on the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

Please refer to Chapter 6.1 Normal Playback for the description of the playback control toolbar and 

right-click menu. Some icons may not available for ATM playback. 

6.4 Synchronous Playback 

Purpose: 

In synchronous playback, the video files can be played in synchronization. 

Note: Video files from up to 16 cameras can be played simultaneously. 

Steps: 

1. Open the Remote Playback page. 

2. In the camera list, check to select the cameras for playback.  

Note: At least two cameras are during playback. 

3. In the File Type dropdown list, you can select the file type to narrow down the search scope and 

search for only the video files for certain types. 

4. Check Synchronous Playback checkbox to enable playing the video files synchronously. 

Note: Set the window division in multi-window division so that you can enable this function. 

5. In the calendar panel, click to select date you want to search. 

6. Click Search to search the video files and the camera under playback will start synchronous 

playback. 
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6.5 VCA Playback 

Purpose: 

You can set VCA rule to the searched video files and find the video that motion detection occurs. This 

function helps to search out the video that you may be more concerned and mark it with red color. 

VCA Search: Get all the related motion detection events that occurred in the pre-defined region. 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera and start the normal playback. Refer to Chapter 6.1 Normal Playback. 

3. Right-click on the display window and click VCA Search to open the VCA Search sub menu. 

4. Draw the detection region. 

1) Click Draw Area. 

2) Click and move on the playback window to set the grid rectangle as the detection region. 

Or you can click All Regions to set all the area shot by the camera as the detection region. 

5. In the VCA Search sub menu, set the sensitivity as 1, 2, or 3. 

6. (Optional) To delete the drawn region or line, click Delete Area to remove it. 

7. Click Search. 

The VCA events occurred in the defined area will be red marked on the timeline.  

 

8. (Optional) Click Previous Event or Next Event or view the previous and next event. 

6.6 Fisheye Playback 

Purpose: 

You can play the video files in fisheye expansion mode. 

Steps: 

1. Open the Remote Playback page. 
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2. Select the camera and start the normal playback. Refer to Chapter 6.1 Normal Playback. 

3. Right-click on the video and select Fisheye Expansion to enter Fisheye Expansion Mode.  

Note: The mounting type of fisheye expansion in playback is set according to the mounting type 

in live view. 

You can select the expanding mode for playback as desired. 

 Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed. 

This view mode is called Fisheye because it approximates the vision of a fish’s convex eye. 

The lens produces curvilinear images of a large area, while distorting the perspective and 

angles of objects in the image. 

 Panorama/Dual-180
o 

Panorama/360
o
 Panorama: In the Panorama view mode, the 

distorted fisheye image is transformed to normal perspective image by some calibration 

methods. 

 PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or 

Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ. 

Note: Each PTZ view is marked on the Fisheye view and Panorama view with a specific 

navigation. You can drag the navigation on the Fisheye view or Panorama view to adjust the 

PTZ view, or drag the PTZ view to adjust the view to the desired angle. 

 

Please refer to Chapter 6.1 Normal Playback for the description of the playback control toolbar and 

right-click menu.   
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Chapter 7  Event and Alarm Center 

The information of recent alarms and events can display in the Event and Alarm Center.  

Click  in Alarms and Events Toolbar to show the Alarms and Events panel.  

 

You can click  to display the Alarm Event page. 

 

Note: Before you can receive the alarm information from the device, you need to click Tool->Device 

Arming Control and arm the device by checking the corresponding checkbox. 

  

On the Alarms and Events panel, the following toolbar buttons are available: 

 Clear Info Clear the information of alarms and events displayed on the list. 
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Enable/Disable Alarm 

Triggered Pop-up Image 
Click to enable/disable image pop-up when alarms occur. 

  Audio On/Mute Click to enable/disable the audio warning for the alarm. 

  Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel. 

 Maximize Maximize the Alarms and Events panel in a new tab page. 

  Show/Hide Click to show/hide the Alarms and Events panel. 

7.1 Viewing Alarms Information 

Purpose: 

Different alarm types can display on the panel: Motion Detection, Video Exception, Alarm Input, and 

Device Exception. You can check the checkbox to enable the displaying of that type alarm. 

Before you start: 

To display the alarms, the event parameters need to be configured. 

Steps: 

1. Click Alarm tab. 

2. Check the checkboxes of different alarm types in the bottom of the page. 

When an alarm occurs, the alarm information, including the time, source, details and content 

will display.  

3. Click  to get a live view of the alarm triggered camera.  

 

You can view the live video of the triggered camera. You can click Previous or Next to view the 

previous or next alarm information. 

4. Click  to send an email notification of the alarm to one or more receivers if the email 

settings are properly configured (refer to Chapter 10.2.5 Email Settings). 

5. Click under the Note column to input the description for the alarm. 

6. (Optional) To clear the alarm information, click , or right-click on an alarm log and click Clear. 

7.2 Viewing Events Information 

Purpose: 

The abnormal events of the client software, such as the live view failure, device disconnection, can 
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also display. 

Steps: 

1. Click Event tab.  

2. Check the checkboxes of different alarm types in the bottom of the page. 

The event information, including the time and details will display. 

3. (Optional) To clear the event information, click , or right-click on the event log and click 

Clear. 

  

7.3 Viewing Pop-up Alarm Information 

After enabling the linkage action of Notify Surveillance Center in Camera Settings, and enabling the 

Enable Alarm Triggered Pop-up Image function in Alarm Event page, the alarm image will open 

when the corresponding event/alarm is triggered.  

 

You can view the live video of the triggered camera.  

You can click Previous or Next to view the previous or next alarm information. 

 

  



User Manual of iVMS-4200 

67 

Chapter 8  E-map Management 

Purpose: 

The E-map function gives a visual overview of the locations and distributions of the installed cameras. 

You can get the live view of the cameras on the map, and you will get a notification message from 

the map when alarm is triggered.  

Click  on the control panel, or click View->E-map to open the E-map page. 

 

E-map Page 

1  Group List 

2  Map Display Area 

3  E-map Toolbar 

8.1 Adding an E-map 

Purpose: 

An E-map needs to be added as the parent map for the hot spots and hot regions. 

Steps: 

1. Open the E-map page. 

2. Select a group for which you want to add a map. 

3. Click Add Map in the Map Display Area to open the map adding window. 
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4. Input a descriptive name of the added map as desired. 

5. Click  and select a map file from the local path.  

6. Click OK to save the settings. 

Notes:  

 The picture format of the map can only be *.png, *.jpg or *.bmp. 

 Only one map can be added to a group. 

The added map displays in the Map Display Area. Use the mouse wheel or click  or , to zoom 

in or zoom out on the map. You can drag the yellow window in the lower-right corner or use the 

direction buttons and zoom bar to adjust the map area for view. 

 

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or 

map preview mode. 

E-map Toolbar in Map Editing Mode: 

 

E-map Toolbar in Map Preview Mode: 

 

 

On the E-map page, the following toolbar buttons are available: 

 Modify Map Modify the map information, including the map name and file path. 
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 Delete Map Delete the current map. 

 Add Hot Spot Add a camera as the hot spot on the map. 

 Modify Hot Spot Modify the information of the selected hot spot. 

 Delete Hot Spot Delete the selected hot spot. 

 Add Hot Region Add a map as the hot region on the current map. 

 Modify Hot Region Modify the information of the selected hot region. 

 Delete Hot Region Delete the selected hot region. 

 Clear Alarm Info Clear the alarm information displayed on the map. 

 Back to Parent Map Go back to the parent map. 

8.2 The Hot Spot Function 

Purpose: 

You can add the cameras as hot spots on the map. The hot spots show the locations of the cameras, 

and you can also get the live view and alarm information of the surveillance scenarios through the 

hot spots. 

8.2.1 Adding Hot Spots 

Adding Cameras as Hot Spots 

Steps: 

1. Click Edit Map in the E-map toolbar to enter the map editing mode. 

2. Click  in the toolbar to open the Add Hot Spot window. 

 

3. Check the checkboxes to select the cameras to be added. 

4. (Optional) Click the Hot Spot Name or Hot Spot Color field to edit the name and color.  

5. Click OK to save the settings.  

The camera icons are added on the map as hot spots and the icons of added cameras changes 

from  to  in the group list. You can drag the camera icons to move the hot spots to the 

desired locations. 

You can also drag the camera icons from the group list to the map directly to add the hot spots. 
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8.2.2 Modifying Hot Spots 

Purpose: 

You can modify the information of the added hot spots on the map, including the name and the 

color. 

Steps: 

1. Click Edit Map in the E-map toolbar to enter the map editing mode. 

2. Select the hot spot icon on the map and click  in the toolbar, or right-click the hot spot icon 

and select Modify, or double-click the hot spot icon on the map to open the Modify Hot Spot 

window. 

 

3. Edit the hot spot name in the text field and select the color, and the linked camera. 

4. Click OK to save the new settings. 

To delete the hot spot, select the hot spot icon and click  in the toolbar, or right-click the hot 

spot icon and select Delete. 

8.2.3 Previewing Hot Spots 

Steps: 

1. Click Map Preview in the E-map toolbar to enter the map preview mode. 

2. Double-click the camera hot spots, or right-click it and select Live View to start live view of the 

cameras.  

3. If there is any alarm triggered, an icon  will appear and twinkle near the hot spot. Click the 

alarm icon, and you can check the alarm information, including alarm type and triggering time. 

Note: To display the alarm information on the map, the Notify Surveillance Center action needs to be 

set as the alarm linkage action for the camera. For details, refer to Chapter 4 Camera Settings. 
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8.3 The Hot Region Function 

Purpose: 

The hot region function links a map to another map. When you add a map to another map as a hot 

region, an icon of the link to the added map is shown on the main map. The added map is called child 

map while the map to which you add the hot region is the parent map. 

Note: A map can only be added as the hot region for one time. 

8.3.1 Adding Hot Regions 

Before you start: 

Add a map to another group. 

Steps: 

1. Click Edit Map in the E-map toolbar to enter the map editing mode. 

2. Select an added map as the parent map. 

3. Click  in the toolbar to open the Add Hot Region window. 
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4. Check the checkbox to select the child map to be linked. 

5. (Optional) Click the Hot Spot Name or Hot Spot Color field to edit the name and color. 

6. Click OK to save the settings.  

The child map icons are added on the parent map as the hot regions. You can drag the child map 

icons to move the hot regions to desired locations. 

8.3.2 Modifying Hot Regions 

Purpose: 

You can modify the information of the hot regions on the parent map, including name, color, icon, 

etc. 

Steps: 

1. Click Edit Map in the E-map toolbar to enter the map editing mode. 

2. Select the hot region icon on the parent map and click  in the toolbar, or right-click the hot 

spot icon and select Modify, or double-click the hot region icon to open the Modify Hot Region 

window.  

 

3. Edit the hot region name in the text field and select color, icon and linked child map. 

4. Click OK to save the new settings. 

To delete the hot region, select the hot region icon and click  in the toolbar, or right-click 

the hot spot icon and select Delete. 

8.3.3 Previewing Hot Regions 

Steps: 

1. Click Map Preview in the E-map toolbar to enter the map preview mode. 

2. Click the hot region icon to go to the linked child map. 

The hot spots can also be added on the hot regions. 

3. Click  in the toolbar to go back to the parent map.  

4. Click  in the toolbar to clear the alarm information. 
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Chapter 9  Log Search 

Purpose: 

You can search and check the log files of the client software stored on the local PC. Three types of log 

files are provided: alarm log, operation log, and system log.  

 Operation Log: The log files of the operations of iVMS-4200 Client Software, such as starting 

live view, starting playback, etc. 

 System Log: The log files of user login and logout. 

 Alarm Log: The log files of all the alarms received by the client. 

Click  on the control panel to open the Log Search page. 

 

9.1 Searching Log Files 

Steps: 

1. Open the Local Log Search page. 

2. Select the log type as Operation Log, System Log, or Alarm Log. 

3. According the log type, select the minor type for the log. 

4. Set the user, camera group, and camera for the logs to search. 

5. Specify the start time and end time for search 

6. Click Search.  

The log files between the start time and end time will display on the list. 

You can check the operation time, content and other information of the logs. 

Note: Please narrow the time range or filter the log type for search if there are too many log files. 
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9.2 Backing up Log Files 

Purpose: 

You can export the log files for backup. 

Steps: 

1. Set the condition and search the log file. 

2. Click Backup to open the Log Backup window. 

 

3. Click  and select a local saving path and set a name for the file. 

4. Click Backup to export the selected log file for backup. 

You can click FileOpen Log File to check the information of the backup log files on local PC. 
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Chapter 10  Account Management and 

System Configuration 

10.1 Account Management 

Purpose: 

You can add multiple user accounts to the client software, and assign different permissions for 

different users if needed. 

Click  on the control panel, or click Tool->Account Management to open the Account 

Management page. 

 
Note: The user account you registered to log in to the software is set as the super user. 

10.1.1 Adding the User 

Steps: 

1. Open the Account Management page. 

2. Click Add to open the Add User window. 

  
3. Select the user type from the drop-down list.  

Two types of user accounts are selectable: 

Administrator: The administrator account has all permissions by default, and can modify the 

passwords and permissions of all operators and its own account. 

Operator: The operator account has no permission by default and you can assign the 

permissions manually. An operator can only modify the password of its own account. 
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4. Input the user name, password and confirm password as desired.  

We highly recommend you to use a strong password to ensure your data security.  

5. Check the checkboxes to assign the permissions for the created user.  

6. (Optional) Click Default to restore the default permissions of this user. 

7. Click Save to save the settings.  

 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length 

of the password cannot be less than 6 characters. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

Note: Up to 50 user accounts can be added for the client software. 

10.1.2 Managing the User 

Purpose: 

After created successfully, the user account is added to the user list on the Account Management 

page. You can edit or delete the information of the user accounts. 

To edit the information of the user, select the user from the list, and click Modify, or double-click the 

user name to enter the Modify User window. 

To delete the information of the user, select the user from the list, and click Delete. 

Note: The super user cannot be deleted and only the password of the super user can be edited. 

10.2 System Configuration 

Purpose: 

The general parameters, live view and playback parameters, image parameters, file saving paths, icon 

of live view and playback toolbar settings, keyboard and joystick shortcuts, alarm sounds, email 

settings and video intercom parameters can be configured. 

Click  on the control panel, 

or click System->System Configuration to open the System Configuration page. 



User Manual of iVMS-4200 

77 

 

Note: You can click Default to restore the defaults of all the system configurations. 

10.2.1 General Settings 

Purpose: 

You can set the frequently-used parameters, including the log expiry time, network performance, etc. 

Steps: 

1. Open the System Configuration page. 

2. Click General tab to enter the General Settings page. 

 

3. Configure the general parameters. 

Parameters Descriptions 

Log Expiry Date The time for keeping the log files, once exceeded, the files will be deleted. 

Maximum Mode 
The maximum mode of the video in live view or playback. It can be set as 

Full Screen, 4:3, or 16:9. 

Pre-Play for Set the pre-play time for instant playback. By default, it is 3 minutes. 

Network Performance The current network conditions. It can be set as Low, Middle, or High. 
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CPU Performance The CPU performance. It can be set as Low, Middle, or High. 

Enable Auto-login Log into the client software automatically. 

Prioritize Playback of 

Video Files on Storage 

Server 

Play back the video files recorded on the storage server preferentially.  

Otherwise, play back the video files recorded on the local device. 

Resume Latest Live View 

Status after Restart  
Resume the latest live view status after you log into the client again. 

Auto Time Adjustment Adjust the time automatically at a specified time point. 

4. Click Save to save the settings. 

10.2.2 Image Settings 

Purpose: 

You can set the image parameters for live view and playback, such as highlight, VCA rule, etc. 

Steps: 

1. Open the System Configuration page. 

2. Click Image tab to enter the Image Settings page. 

  

3. Configure the image parameters. 

Parameters Descriptions 

Enable Highlight 
Mark the detected objects with green rectangles in live view and 

playback. 

VCA Rule Display the VCA rule in the live view. 

Auto-change Stream Type 

Change the video stream (main stream or sub-stream) automatically in 

live view according to the window division. When the window division 

is larger than 9, it will switch to sub-stream automatically. Or it remains 

main stream. 

4. Click Save to save the settings. 

10.2.3 File Saving Path Settings 

Purpose: 

The video files from manual recording, the captured pictures and the system configuration files are 

stored on the local PC. You can set the saving paths of these files. 

Steps: 

1. Open the System Configuration page. 

2. Click File tab to enter the File Saving Path Settings page. 
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3. Click  and select a local path for the files. 

4. Click Save to save the settings. 

10.2.4 Alarm Sound Settings 

Purpose: 

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client 

can be set to give an audible warning and the sound of the audible warning can be configured. 

Steps: 

1. Open the System Configuration page. 

2. Click Alarm Sound tab to enter the Alarm Sound Settings page. 

  

3. Select the alarm sound. 

There are four pre-defined alarm sound type in the list. You can click  and select the audio 

files from the local path for different alarms. 

4. (Optional) Click  for a testing of the audio file. 

5. Click Save to save the settings. 

Note: The format of the audio file can only be *wav. 

10.2.5 Email Settings 

Purpose: 

An email notification can be sent when a system alarm occurs. To send the email to some specified 

receivers, the settings of the email need to be configured before proceeding. 

Steps: 
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1. Open the System Configuration page. 

2. Click Email tab to enter the Email Settings page. 

 
3. Input the required information. 

SMTP Server: Input the SMTP Server address. 

Encryption Type: Select the encryption type. 

Port: Input the communication port of email service. The port is 25 by default. 

User Name: Input the user name of the sender email address if Server Authentication is 

checked. 

Password: Input the password of the sender Email address if Server Authentication is checked. 

Sender’s Address: Input the email address of the sender. 

Receiver’s Address: Input the email address of the receiver. 

4. (Optional) Check Enable SSL checkbox to increase the security of email sending. 

5. (Optional) Click Send Test Email to send an email to the receiver for test. 

6. Click Save to save the settings. 
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Appendix 

System Requirements 

 Client Requirements 

Recommended 

Processor Intel® Core™ i3 3GHz 

Memory 4 GB of RAM 

Video Card AMD Radeon HD 6470M 256M 

High Performance 

Processor Intel® Core™ i7 2GHz 

Memory 4 GB of RAM 

Video Card AMD Radeon HD 6490M 256M 

 Maximum Number of Cameras Viewed per Client under Different System Requirements 

Encoding 

Format 
Resolution 

Bit Rate 

(Mbps) 

Frame 

Rate 

(fps) 

Maximum Number of Cameras Viewed Simultaneously 

Recommended High Performance 

H.264 

720P 1 25 13 18 

1080p 4 25 4 5 

8 MP 16 25 1 2 

H.264+ 

720p 1 25 11 19 

1080p 3 25 5 6 

3 MP 4 25 3 6 

H.265 

720p 1 25 3 7 

1080p 3 25 1 3 

3 MP 4 25 1 3 

H.265+ 

720p 0.5 25 7 15 

1080p 1 25 3 6 

3 MP 2 25 1 3 

Note: The above parameters are estimated and for reference only. Under the same resolution and frame rate, 

the bitrate of different camera manufacturers may be different. Moreover, the decoding performance may also 

be different for different manufacturers. 

Specifications 

Model iVMS-4200 

Database SQLite 

Client General 

User Support up to 50 users and one super user 

E-map Support up to 256 maps 

Encoding Device Support up to 256 encoding devices 

Decoding Device Support up to 64 decoding devices 
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Group 
Support up to 256 groups 

Support up to 64 channels for each group 

Channel Support up to 1024 channels for all groups 

Storage Server Support up to 16 Storage Servers 

Stream Media Server Support up to 16 Stream Media Servers 

Video 

Live View Support up to 64-ch live view at a time 

Playback Support up to 16-ch playback at a time 

Synchronous Playback Support up to 16-ch synchronous playback  

FAQ 

Live View 

Question:  

How to get the live view for the channels in the remote client? 

Answer:  

Steps: 

1. Add the device into the software device list; please refer to Chapter 3.1 Adding the Device for 

more details. 

2. Add cameras into a group. Please refer to Chapter 3.2 Group Management for detailed 

information. 

3. Open the Main View page from the Control Panel, and drag the camera from the group list on 

the left side to the display window. Refer to Chapter 5.1 Starting and Stopping the Live View. 

Playback 

Question: How to search for video files recorded of certain event mode?   

Answer:  

Steps: 

1. Go to Event Search page and select an event type: motion or alarm (i.e. alarm input). 

2. Choose a camera in the group and specify a start time, then click Search. 

3. Select a window, and double-click a video file from the search results list to play the video of 

that channel. 

Configuration 

Question: How to set encoding parameters in the device configuration?   

Answer:  

The encoding parameters should be set separately for each camera, and it is configured in Camera 

Settings setup page. Click  on the control panel to enter the Camera Settings page. 

0104001070914  
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